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Filtering  
You can filter to select records that match specific criteria. This gives a temporary view of data without 

physically removing anything. To isolate individuals from Florida, we would do the following:   

 1. Choose Data tab > Sort & Filter group > Filter 

 
3. Click the drop-down for the column you want to filter.  The filter menu appears and allows you 

to sort and apply filters. Excel will recognize the type of data you have in the column. I.e., text, 

dates, or values.  You will see each unique value listed once in the bottom part of the options. 

 
  

2. A drop-down arrow will appear in the header cell for each column. 
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4. Uncheck the box next to Select all to quickly deselect all data.  Then check the box(es) of the 

data you want to filter.  Click OK.  (we selected 3M in this example) 

 
5. Only Company Name 3M results will be displayed. 

 
6. Apply multiple filters to help narrow down your results.  We will select Representative R02 from 

the Representative column and only see results for company name 3M and representative R02. 
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CLEAR A FILTER  
After applying a filter, you may want to remove the filter.  

1. Click the drop-down for the filter you want to clear. We will clear the filter for the 
Representative. 

2. Choose clear filter from. 

 

3. The hidden data will be displayed. 

FILTER WITH SEARCH  
Excel allows you to search for data that contains a phrase, word, number, date, etc.  Excel auto-selects 

the items that match your criteria.   

1. Click the drop-down for the column you want to filter. 

2. Click in the Search box and start typing.  Excel selects all items that match your criteria. Click OK 
when you’re done. 

 

APPLY ADVANCED FILTERS  
1. Click the drop-down for the column you want to filter.  We filter Purchase amount numbers 

greater than or equal to $20,000. 

2. Hover over Number Filters, then select the desired number filter (ours will be Greater than or 

equal to).  Notice these are all logical references. 
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3. Type in the desired number(s) to the right of each filter.  Click OK. 

 
4. Only numbers that are 20,000 and greater are displayed. 

SUBTOTALS  
1. Sort the list on the field for which you want subtotals inserted. Data Tab >> Sort & Filter >> AZ 

 
2. From the Data tab, in the Outline group, select Subtotal. 

3. Select the field for which the subtotals are to be calculated in the At Each Change in dropdown. 

4. Specify the types of totals you want to insert in the Use Function dropdown. 

5. Select the check boxes for the field(s) you want to total in the Add Subtotal To list box. 

6. Click OK. 
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VIEW GROUPS BY LEVEL  
1. The worksheet will be outlines into group and the subtotal will be listed below each group.  In 

this example, the data is grouped by company name and the total purchase amount is being 
totaled. 

 
2. Your worksheet is divided into different levels.  You can switch among these levels quickly and 

control how much information is being displayed. 

a. Level 1: Grand Total 

 
b. Level 2: Subtotals and Grand Total 

 
c. Level 3: All information is displayed. 

 

REMOVE SUBTOTALS  
1. Data Tab >> Outline Group >> Subtotal. 

2. Choose the Remove All Button. 
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Creating a Table  
There are two ways to create a table. You can either insert a table directly in the default table style or 

you can convert an existing range into a table. The second approach is by far the most common:   

1. Insert Tab >> Table. 

 
2. A Create Table dialog box will appear. Your selected range appears as an absolute cell reference. 

Your range will already be selected and displayed in the Where is the data for your table? 

 

3. If your selected range contains data that you want to display as table headers, select the My 

table has headers check box. 

4. Click the OK command button to create the table. 

5. When you have an Excel table selected, you will have access to a Table Tools contextual tab with 

a single Design sub-tab. 

Each time you create a table, Excel creates a default table name in the Properties group (e.g., Table1, 

Table2, etc.). The scope of the table name is for the entire workbook.  

ADD A TOTAL ROW  
1. Click anywhere in the table. 

2. On the Design Tab, within the Table Style Options group, select Total Row check box. 

 
3. The total row appears as the last row in the table and displays the word Total in the left most 

cell. If you do not want any total in the right most cell, click the drop-down and select none. 
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4. In the total row, click the cell in the column for which you want to calculate a total, and then 

click the dropdown that appears. 

5. In the dropdown list, select the function that you want to use to calculate the total. 

 

Results:  

 
Note: Each column has this same functionality. And the total row is “connected” to the filter.  
When you filter for criteria, the total row will automatically update the numbers and display 

them only for the criteria you specify.   
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CHANGE A TABLE STYLE 
1. Select any cell in your table.  Click the Table Tools >> Design Tab.  Click the Dropdown for Table Styles.  

 
2. Select from the styles provided.  

 
 

REMOVE A TABLE 
1. Select any cell in your table.  Click the Table Tools >> Design Tab.   
2. From the Tools Group, select Convert to Range.  

 
3. Click Yes.  
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PivotTables & Pivot Charts  
A PivotTable interactively allows for quickly summarizing large amounts of data. You can rotate its rows and 
columns to see different summaries of the source data, filter the data by displaying different pages, or display 
the details for areas of interest. Pivot Charts are associated with PivotTables and provide graphical 
representations of the same information.  
 
Use a PivotTable when you want to compare related totals, especially when you have a long list of figures to 
summarize and you want to compare several facts about each figure. Because a PivotTable is interactive, you can 
change the view of the data to see more details or calculate different summaries. This gives a customized 
perspective on the data without having to change anything in the range of cells it is based on.  
 

CREATING A PIVOTTABLE 
1. Click a cell in the range of cells that contains the data you want to make a 

PivotTable out of. 
2. From the Insert Tab, within the Tables group, click PivotTable.  

 
3. Click OK. Excel adds an empty PivotTable report to a new worksheet. 

 
4. To add fields to the report, click and hold the field name in the field section, and then drag it to an area 

in the layout section.  
 
  



11  

Fields you put in the different layout section are as follows: 
1. Report Filters: filters are shown at the top-level report above the PivotTable and will filter the entire 

table at once. 
2. Column Labels: are shown in column layout (horizontal) at the top of the PivotTable. 
3. Row Labels: are shown in Row layout (vertical) on the left side of the PivotTable. 
4. Values: are shown as summarized numeric values. 

 
 

FORMAT THE VALUES IN THE PIVOTTABLE 
To format the summed values entered as the data items of the pivot table with an Excel number format, follow 

these steps: 

1. Right mouse click the value you wish to update.  Select Number Format. 

 
  

1 2 

3 4 
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2. Make your changes in the Format Cells dialog box (currency, accounting, decimal points, etc.). Click OK.  

The number formats of the entire field will be updated.  

     
 

REPORT LAYOUT 
To change the layout of the PivotTable so it displays the names of the all the fields instead of saying “Row 
Labels”, click the Design Tab of the PivotTable Tools area on your Ribbon.  

 
 
From the Layout group select Report Layout and then Show in Outline Form or Show in Tabular Form. 

 
 
In our example, Row Labels has been updated to the actual field name Representative. 
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SET DEFAULT LAYOUT 
If you have an existing PivotTable laid out the way you like, you can import those settings, otherwise you can edit 
them individually. Changing the default PivotTable settings will affect new PivotTables in any workbook. Existing 
PivotTables aren’t impacted by changes to the default layout. 

1. File >> Options >> Data >> Edit Default Layout 

 
2. Make Edits here to set the default options for PivotTables from this point forward.  
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FILTERING INDIVIDUAL COLUMN AND ROW FIELDS 
The filter buttons attached to the Column and Row field labels let you filter 

out entries for groups and, in some cases, individual entries in the data 

source. To filter the summary data in the columns or rows of a pivot table, 

follow these steps: 

1. Click the Column or Row field's filter button. 

2. Deselect the check box for the (Select All) option at the top of the 

list box in the drop-down list. 

3. Click the check boxes for all the groups or individual entries whose 

summed values you still want displayed in the pivot table.  

4. Click OK. 

As with filtering a Report Filter field, Excel replaces the standard drop-

down button icon for that Column or Report field with a cone-shaped filter icon, indicating that the field is 

currently being filtered and only some of its summary values are now displayed in the pivot table.  

 
To redisplay all the values for a filtered Column or Report field, you need to click its filter button and then click 

(Select All) at the top of its drop-down list. Then click OK. 

SORT A PIVOT TABLE 
You can instantly reorder the summary values in a pivot table by sorting the table on one or more of its Column 

or Row fields. To sort a pivot table, follow these steps: 

1. Click the filter button for the Column or Row field you want to sort. 

2. Click either Sort A to Z or Sort Z to A at the top of the field's drop-down list. 

Click the Sort A to Z option when you want the table reordered by sorting the labels in the selected field 

alphabetically, from the smallest to largest numeric value, or from the oldest to newest date. Click the Sort Z to A 

option when you want the table reordered by sorting the labels in reverse alphabetical order (Z to A), values 

from the highest to smallest, and dates from the newest to oldest.   You can also click in any data in the 

PivotTable and use the Sort and Filter options on the PivotTable Tools Ribbon. 
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MODIFY THE PIVOTTABLE FIELDS 
1. From the Field List: 

a) To remove a field from the table, drag its field name out of any of the drop zones and, when the mouse 

pointer changes to an x, release the mouse button; or click its check box in the Choose Fields to Add to 

Report list to remove it its check mark.  

b) To move an existing field to a new place in the table, drag its field name from its current drop zone to a 

new zone at the bottom of the task pane. 

c) To add a field to the table, drag its field name from the Choose Fields to Add to Report list and drop the 

field in the desired drop zone— note that if you want to add a field to the pivot table as an additional 

Row Labels field, you can also do this by simply selecting the field's check box in the Choose Fields to Add 

to Report list. 

 

PIVOTING THE TABLE'S FIELDS 
As the name pivot implies, the fun of pivot tables is being able to restructure the table simply by rotating the 

Column and Row fields. In the PivotTable Field List pane, simply drag a label from the Row Labels drop zone to 

the Column Labels drop zone and vice versa so that the two field names are swapped. Voilà — Excel rearranges 

the data in the pivot table at your request. 
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MODIFY THE SUMMARY FUNCTION 
By default, uses the SUM function to create subtotals and grand totals for the numeric field(s) that you include in 

a pivot table. Some pivot tables, however, require the use of another summary function, such as AVERAGE or 

COUNT. 

To change the summary function that Excel uses in a pivot table, follow these steps: 

1.  Right-mouse click the field. Select a new summary function in the Value Field Settings dialog box. 

 
2. Change the field's summary function to any of the following functions by selecting it in the Summarize 

Value Field By list box: 

o Count to show the number of records for a particular category (note that Count is the default 

setting for any text fields that you use in a pivot table). 

o Average to calculate the average (that is, the arithmetic mean) for the values in the field for the 

current category and page filter. 

o Max to display the highest numeric value in that field for the current category and page filter. 

o Min to display the lowest numeric value in that field for the current category and page filter. 

o Product to multiply all the numeric values in that field for the current category and page filter (all 

non-numeric entries are ignored). 

o Count Numbers to display the number of numeric values in that field for the current category 

and page filter (all non-numeric entries are ignored). 

o StdDev to display the standard deviation for the sample in that field for the current category and 

page filter. 

o StdDevp to display the standard deviation for the population in that field for the current 

category and page filter. 

o Var to display the variance for the sample in that field for the current category and page filter. 

o Varp to display the variance for the population in that field for the current category and page 

filter. 

3. Click OK. Excel applies the new function to the data present in the body of the pivot table.
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TO ADD COLUMNS 
So far, our PivotTable has only shown one column of data at a time. To show multiple columns, you'll need to 
add a field to the Columns area. 

1. Drag a field from the Rows List (or the Field List) into the Columns area. In our example, we'll use the 
Years field.  

2. The PivotTable will include multiple columns. In our example, there is now a column for each Year.  
 
— Excel rearranges the data in the pivot table at your request. 
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REPORT FILTERS 
Sometimes you may want focus on just a certain section of your data. Filters can be used to narrow down the 
data in your PivotTable, allowing you to view only the information you need. 
To add a filter: 
In our example, we'll filter out certain salespeople to determine how they affect the total sales. 

1. Drag a field from the Field List to the Filters area. In this example, we'll use the Representative field.

2. The filter will appear above the PivotTable. Click the drop-down arrow.  Select an Item from the list.
Click OK.  In this example we will select Representative R03. This filters the table to only show records for
that specific representative.
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3. Check the box next to Select Multiple Items if you wish to select more than one item from the list.  

 
 

4. The PivotTable will adjust to reflect the changes. 

 
 

GROUP DATES 
In Excel 2016 and later, dates are grouped automatically.  To customize the grouping to fit your needs: 

1. Right mouse click any date >> select Group 
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2. Months, Quarters and Years are automatically selected.  We will group only by years.  Deselect Quarters, 
and Months. Click OK.  

      
3. Group by Year and then month.  

Right mouse click any month.  Select Group.  >> Select Years. Click OK.  

                                    
 
Results: 
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CONDITIONAL FORMATTING 
Excel's conditional formatting lets you change the appearance of a cell based on its value or another cell's value. 

You specify certain conditions, and when those conditions are met, Excel applies the formatting that you choose. 

You might use conditional formatting to locate dates that meet a certain criterion (such as falling on a Saturday 

or Sunday), to call out the highest or lowest values in a range, or to indicate values that fall under, over, or 

between specified amounts. 

1. Select the cells to which you want to apply conditional formatting.  In some cases, you will select a single 

column or row of data in a table rather than an entire table. 

2. On the Home tab, in the Styles group, click the Conditional Formatting button. A menu appears with 

several different options for specifying the criteria. 

3. Point to Highlight Cell Rules and then select the type of criterion you want to use. Criteria options include 

Greater Than, Less Than, Between, Equal To, Text That Contains, A Date Occurring, and Duplicate Values. 

A window open where you can specify the values.  

            

       
4. Enter the values you want reference in the text box (if 

necessary). Click the drop-down arrow next to the 

format options and select the desired formatting. In the 

above example everything this is greater than 150000 will 

be a light red fill. 

5. Click OK.   

6. To clear the formatting, click Conditional Formatting (Home Tab, Styles group).  Select Clear Rules >> 

Clear Rules from Entire Sheet.  

 

CALCULATED FIELD 
You can add calculated fields to PivotTables that perform calculations on the data in the table. For example, in 
the sample worksheet, you could create a calculated field that will calculate a bonus for each employee that is 
3% of the profit total.  

1. To start, click to select any cell in the PivotTable. Next, click PivotTable Tools – Analyze >> 
Calculations>>Fields, Items, & Sets >> Calculated Field: 
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2. This action will open the Insert Calculated Field dialog:  

 
3. First you need to set a name for this new field. This example will show a 10% increase in order amounts.   

 
4. Next, you need to enter the formula for this new field.  Delete the Zero (0) in the Formula text box.  Then 

Double click on the field you want to add.  Use Excel’s usual arithmetic operators.  

  
5. With the calculated field now complete, click Add to save it: 
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6. Click OK to close the dialog: The new calculated field will now automatically appear in the PivotTable:  

 
 

TIMELINES IN PIVOTTABLES 
You can now insert a Timeline in a PivotTable if you have date fields to work with!  

1. Analyze Tab >> Filter Group >> Insert Timeline. 

 
2. Select your field. Note: only date and time fields will appear.  

 
3. Adjust how you want to filter your data by click in the dropdown in the upper right corner. Pick From 

Years, Quarters, Months, Days.  
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4. Select from the timeline by clicking and dragging.  

 
 

SLICERS IN PIVOTTABLES 
Slicers allow you to quickly filter PivotTables and Charts.  

1. Select Analyze >> Filter Group >> Insert Slicer.  
2. Select the fields you wish to filter by.  Click OK.  
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3. The slicers will be added.  Simply select the items you wish to see.  Hold down the ctrl key to select 
multiple items at once. Notice the Clear Filter button in the upper right corner of each slicer.  

 
4. Click on the data you want to filter by.  Hold your Ctrl key down to select multiple items. 

 
5. Click the clear button on the Slicer to clear the filter.  

 
6. You can select Multi Select to remove several items at once.  
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CREATE A PIVOTCHART 
Pivot Charts are like regular charts, except that they display data from a PivotTable. Just like regular charts, you'll 
be able to select a chart type, layout, and style that will best represent the data. 
 

1. Select any cell in your PivotTable 
2. From the PivotTable Tools Analyze Tab select PivotChart from Tools group. You can also use the Insert 

Tab >> Charts >> PivotChart 
3. The insert chart dialog box will appear. Select the desired chart type and layout, then click OK.  

 
NOTE: you can expand and collapse items on the chart by using the Plus/Minus button in the lower right 
corner of the chart.  

 

CONNECT SLICERS AND TIMELINES TO MANY PIVOTTABLES 
If you have several pivot tables and charts in one worksheet you might want to use slicers and timelines to filter 
all your data at once.  The process is very simple.  Insert all your Pivot Tables and charts first.  Then insert your 
slicers and timelines.  Then connect each slicer and timeline to each of your pivot tables using the following 
process.  

1. Right mouse click the slicer or timeline.  Select Report Connections…. 

 
2. Each Pivot Table will be listed.  Check the box next to each one you want the slicer / timeline to connect 

to.    Click OK.  

      
Your slicers and timelines will filter all Pivot Tables and charts at the same time.  
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DATA MODEL 
1. Convert data to tables first.  You must convert the range into a table for the Data Model feature to work.  

a. Insert Tab >> Table 
b. Use the Table Tools Design Tab >> Properties Group >> and name the table 

 
2. Create the Relationship 

a. Data Tab >>  Data Tools Group >> Relationships 

 
b. Click New.  

 
c. You will relate your two tables by the common field in this window.  

 
3. Create a PivotTable 

a. Insert Tab >> PivotTable 
b. In the Create PivotTable window click the check box for Add this data to the Data Model.  This 

will give you access to both related tables within the PivotTable!  Click OK.  
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4. In the PivotTable Fields panel, choose All instead of Active.  You will now be able to add fields from both 
tables.  

 
5. Example: you can add names from the Policy table and amounts from the Claims Table.  

 
 

Drill down feature will allow you to drill into either of the tables.  

 

 


